
Tell me about FTP

File Transfer Protocol (FTP) is an Internet standard for exchanging files. Businesses, services and 
other organizations from around the world have set up FTP sites to provide access to their files. 
Although many of these sites are not available to the public, anonymous FTP allows organizations to 
share some of their resources with the public without risking proprietary information.

To use FTP, you need to know the address of the FTP site. Some FTP sites require a user name and 
password when you connect, while other sites allow you to connect anonymously. Once you connect 
to an FTP site, you can browse for files and retrieve them from the site. Some FTP sites allow you to 
upload files, usually to the site’s “Incoming” folder.

You can use FTP to transfer binary files or large files over great distances. However, some FTP sites 
have restrictions, such as firewalls (domain barriers) that control accessibility to their computers from 
outsiders.

Preparing to Use FTP 

After logging    on to an FTP site, the files you transfer are binary or ASCII files. You can set up 
Cyberjack FTP to use either of the following modes for file transfer:

 Binary mode in which the file transfers are unchanged.
 ASCII mode in which text files are transferred with the conversions required for going from MS-
DOS to UNIX.

Use the appropriate transfer mode based on the file type. Sending text files between MS-DOS and 
UNIX in binary mode, or sending binary files in ASCII mode can corrupt the files.

Tip

If you are new to Cyberjack or the Internet, connect to the Cyberjack Web page. Check this site 
for updates, FAQs (Frequently Asked Questions) about Cyberjack, helpful hints and interesting places to 
visit. 

The Cyberjack Web page is available at:
http://www.cyberjack.com/



Cyberjack FTP

To retrieve a file with Cyberjack FTP

1. On the FTP menu, click New. The New Site dialog appears.

2. In the Name field, type the name of the site.

3. Click OK. FTP connects to the FTP site and displays the folders and files available.

4. Click the file you want to transfer to your default download folder. 

Cyberjack FTP downloads the file to your default download folder.

Tips

 To download and open a text file, right click it, and click View Text File.
 If you are not sure how you can use certain files at FTP sites, highlight a file and click Properties on the Item 
menu. Click the Permissions tab to see if you can retrieve, write or execute files at the site.



Cyberjack FTP

To send a file with Cyberjack FTP

1. On the FTP menu, click New. The New Site dialog appears.

2. In the Server section, type your service provider’s name in the Name field.

3. In the Login section, do the following: 

 Disable Anonymous FTP.
 In the User Name field, type the name assigned to you by your service provider.
 In the Password field, type the password assigned to you by your service provider.
4. Click OK. Cyberjack FTP connects to the FTP site.

5. Drag and drop the file from your computer to a folder on the FTP site. The Sending dialog appears. Cyberjack 
FTP uploads the file to your personal folder at your service provider. If you need to stop the transfer, click 
Cancel.

6. To refresh the window display after downloading files, click Refresh on the View menu.

Tip

 To speed up the sending process, compress files using Zip manager before sending them over the Internet. 
For details on using Zip Manager, click here 



Cyberjack FTP

To save an FTP item to your Guidebook

1. On the FTP site menu, click Save. The Save As dialog appears. 

2. In the Save In field, click the Guidebook folder in which you want to save your new FTP CyberLink. 



Cyberjack FTP

To return to previously viewed sites and files

1. On the FTP Site menu, click New. The New Site dialog appears.

2. In the Name drop-down list, select an address. Cyberjack FTP connects to the FTP site and displays the item.



Cyberjack FTP

To create a folder at your service provider

1. Connect to your service provider’s FTP site.

2. On the Item menu, click Create New Folder. The Create New Folder dialog appears

3. Type the name of the new folder.

 Related Topics



Cyberjack FTP

To open a folder by typing its name

1. Connect to the FTP site where you want to open a folder.

2. On the Item menu, click Change Folder. The Change Folder dialog appears.

3. Type the name of the folder. The folder opens and the contents are displayed.

 Related Topics



Cyberjack FTP

To change the appearance of connection messages

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the Appearance tab.

3. In the Item drop-down list, click any of the following:

 Server Code to change the font, size and color of the message numbers from the server.
 Server Message to change the font, size and color of the messages from the server. 
 Server Error Message to change the font, size and color of the error messages from the server.
 Client Command to change the font, size and color of the command messages issued from Cyberjack FTP 

to the server.
 General Information to change the font, size and color of the general messages from the server.
 IDS to change the background color.
4. In the Font drop-down list, click a new font for the selected text.

5. In the Size drop-down list, click a new size for the selected text.

6. In the Color drop-down list, click a new color for the selected text.



Cyberjack FTP

To change the transfer data type

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the General tab.

3. In the Transfer data type section, click one of the following:

 Binary to retrieve executable programs, graphics files and text files.
 ASCII to retrieve ASCII text files.

Notes

 You can change the mode of data transfer (binary data type is the default).
 In the Text Viewer field, type a program to display text files when View Text File has been selected from the 

right click menu. For example, you can type ...
Notepad.exe

... to display the text file you download.



Cyberjack FTP

To change the logon attempts

1. On the Setup menu, click Options. The FTP Options dialog appears. 

2. Click the General tab.

3. In the Login Retries field, select the number of logon attempts.

4. In the Delay on keyboard select field, select the time delay for Cyberjack FTP to display the contents. A longer 
time delay refreshes the display of folders slowly so that you can scroll quickly.



Cyberjack FTP

To change the firewall settings

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the Firewall tab.

3. Enable Use Firewall.

4. In the Type section, select the type of firewall. 

5. In the Name field, type your user name.

6. In the User ID field, type your user ID.

7. In the Password field, type your password.

Notes

Change the firewall settings if you connect to the Internet through a firewall host. Make sure you enter the 
correct information, including the port that is used for the firewall. If you do not know the port, leave the default 
setting.

You can specify the firewall type using any of the following settings:
– Site Hostname to use firewall host, user ID and password. The following message is sent to the firewall 

when you connect:

SITE remote_host

– User After Logon to use the firewall host, user ID and password. The following message is sent to the 
firewall when you connect:

USER remote_userid@remote_host

– User With No Logon to only use the firewall host (user ID and password are ignored). The following 
message is sent to the firewall when you connect:

USER remote_userid@remote_host

– Proxy Open to only use the firewall host (user ID and password are ignored). The following message is 
sent to the firewall when you connect:

OPEN remote_host

Cyberjack FTP does not support SOCKS-based firewalls. To connect to router-based firewalls, enable PASV 
Mode.



Cyberjack FTP

To change the file transfer settings

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the Transfers tab.

3. In the Download path field, type a new folder or click Browse to select a folder for downloading.

4. In the Options section, enable any of the following:

Confirm Before Overwriting Existing Files to be prompted before overwriting a file with the same name as 
the one you are downloading.

View Images as They Download to display image files as they are transferred to Image Manager. 
Check for Viruses in Downloaded Programs to search for viruses in the files you download. 
Automatically Launch Downloaded Files to start the appropriate Windows program for the downloaded file.
Display Transfer History When Complete to let you know when a file transfer is complete.
Minimize Transfer Dialog to minimize the file transfer display.
Confirm File Name When Saving to be prompted to alter the name of the file you are downloading.

Note

Changing the entry in the Download Path field changes the default download folder for all Cyberjack 
programs. To view the contents of the default download folder, click Open Download Folder on the Tools menu.



Cyberjack FTP

To change the notification settings

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the Notification tab.

3. In the When Transfer is Complete section, enable any of the following:

Flash Icon to have the Cyberjack FTP icon flash on the Taskbar (if Cyberjack FTP is minimized) to indicate a 
file transfer is complete.

Restore Minimized Application to restore Cyberjack FTP to your screen when a file transfer is complete.
Play Sound to play a Windows system sound to notify you that a file transfer is complete.
Refresh Host Where Applicable to automatically refresh your display when you transfer files to the FTP site. 

Otherwise, you may download a file and it will not be displayed.
4. In the Group Transfers section, click one of the following:

Notify After Each Transfer to advise you when a file has been transferred.
Notify When All Transfers are Complete to advise you when all files in a group have been transferred.



Cyberjack FTP

To change the cache settings

1. On the Setup menu, click Options. The FTP Options dialog appears.

2. Click the Caching tab.

3. In the Directories and Files section, enable any of the following:

Save Directory Information to save information from the previously viewed FTP sites to the cache. If 
disabled, you can still log on to an FTP site, but the folder structure from the previously saved session will not be 
saved.

Automatically Refresh Dirty Folders to automatically refresh all folders opened in the folder structure of the 
previously saved session. If disabled, you can still log on to an FTP site, but the previously opened folders will not be 
refreshed. To manually refresh all folders, click Refresh on the View menu or click each folder.

Note

Cyberjack FTP uses a cache on your hard drive to store previously viewed FTP sites. A cache is a 
temporary memory store that saves recently accessed data for faster retrieval.





The protocol for moving hypertext files across the Internet. Requires an HTTP client program on one end, and an 
HTTP server program on the other end. HTTP is the protocol used by the World Wide Web (WWW).



The main communications protocol in the Internet suite of protocols that provides reliable, connection-oriented, full 
duplex streams and uses IP for delivery.



Action messages are brief descriptions of what you want the other users to picture you doing. For example, if 
another user says something funny, you might post the action message “Raven giggles”. Action message are 
automatically preceded by your nickname, so write your action in the third person. For example:

*Raven waves hello to everyone



Private action messages are sent only to the specified user, preceded by your nickname. For example:

*> Raven winks at you secretly ...

Your nickname does not appear in the Action field, but it will be the first word of your action message.



Points to a specific Web site.



A file that contains characters other than the standard ASCIIcharacters. Binary files cannot be read like text files; 
they are usually executable programs or compressed files.



An abbreviation for American Standard Code for Information Interchange. This standard code consists of 7 data 
bits (or binary values) per character. Letters, numbers, and special characters (for example, $,ÿ,#, %) are 
represented by different ASCII codes. The ASCII character set represents 96 printable characters and 32 non-
printable control characters.



A Cyberjack bookmark object that as acts a direct shortcut to an Internet site. You can create CyberLinks to your 
favorite sites, and send them to other users through email. Also, any URL you can takes you to another site when 
you double click it is also a CyberLink.



Hypertext Markup file. This file type can be read directly by Cyberjack Web.



A pointer to remote sources on the Internet.



Control the way you search by selecting Exact, Case Sensitive, Case Insensitive or Regular Expression.



When lurking, you are watching the chat to learn more information about the terms and expressions used in the 
chat.







For information on a specific topic, click the item.



Type the name of the FTP site.



Type the port number of the FTP site, or leave the default of 21.



The default FTP server port.



Select the type of server to connect to, or select Auto detect.



Type the name of the folder to open once you have logged on.



For information on a specific topic, click the item.



Type the name of the account on the FTP site.



Type the password for the logon account you are using.



Enable to logon to FTP sites anonymously.



Enable to save the current password.



Starts the Cyberjack FTP Wizard.



Type the password for the logon account.



Type the name of the folder you want to change to.



Enables refreshing of directories read from the cache.



For information on a specific topic, click the item.



Click to accept ASCII text file data transfers.



Click to accept binary data transfers.



Local type data transfers.



Select the parameter for the data transfer type.



For information on a specific topic, click the item.



Select the number of logon attempts when connecting to an FTP site.



Select the time delay before folder contents are displayed.



Enable to specify the firewall type if connecting through a firewall.



Enable to connect to router-based firewalls.



For information on a specific topic, click the item.



Type the name of the firewall to connect through.



Type your user account name on the firewall.



Type your user account password on the firewall.



Type the firewall port number, or leave the default of 21.



Enable to save the password used for firewall access.



For information on a specific topic, click the item.



Click to logon using SITE remote_host syntax.



Click to logon using USER remote_userid@remote_host syntax.



Click to logon using USER remote_userid@remote_host syntax.



Click to logon using OPEN remote_host syntax.



For information on a specific topic, click the item.



Click to give user read permission.



Click to give user write permission.



Click to give user execute permission.



For information on a specific topic, click the item.



Click to give group read permission.



Click to give group write permission.



Click to give group execute permission.



For information on a specific topic, click the item.



Click to give others read permission.



Click to give others write permission.



Click to give others execute permission.



Filename on which the permissions operate.



The filename to which the properties refer.



The type of file.



The location of the file on the server.



The size of the file.



The date the file was created.



The date the file was last modified.



The date the file was last accessed.



Miscellaneous information on the file.



For information on a specific topic, click the item.



Enable to save information and folder structure of the current FTP session.



Enable to refresh folders read from the cache.



Type the text to search for.



Searching information.



Search for folders.



Search for files.



Search for a whole word only.



Find the next matching occurrence of the string.



Type a description for the FTP site, or the site name.





Select the item to change its appearance.



Select a new size for the selected text item.



Select a new color for the selected text item.



Select a new font for the selected text item.



Returns the color, font and size of all items to their default settings.







The status of Cyberjack Ping’s search for the specified Internet address.



The result of Cyberjack Ping’s last data packet sent to the specified Internet address.



The average response time, in milliseconds, of a returned Cyberjack Ping data packet.



Click to have Cyberjack Ping send data packets to the specified site.



Type the site for Cyberjack Ping to diagnose.





Enable any item in this list to display the selected toolbar. You can edit or delete any selected toolbar.



Click to edit the currently selected toolbar.



Click to create a new toolbar.



Click to delete the currently selected toolbar.



Enable to display buttons in color.



Enable to display Tooltips when the mouse cursor is placed over a button.



Enable to display large buttons.



Enable to display Delrina WinFax style buttons.



Enable to display Delrina WinFax style captions for buttons.



Add or remove buttons from the selected toolbar. Click the name of the toolbar to change its name.



Type a new name for the toolbar.



Use these buttons to make up your toolbar. You can drag them up to the toolbar, or click the Add button.



Adds the button highlighted in the available field to the toolbar above. 



Removes the button highlighted in the above toolbar.



Resets the toolbar to its original(default) settings.



Lists the menu options that can be assigned to the buttons.



Specifies the caption that is to be displayed when Delrina Classic button style is chosen with captions.



Specifies the tooltip that is to be displayed for the button.



Specifies the help text that is to be displayed for the button.



Save the changes to the toolbar and continue.



Throw away changes to this toolbar. 



Type the path and name of the folder to receive all downloaded files.



Enable to confirm overwriting existing files.



Enable to view partial images as they are downloading.



Enable to open files when they are downloaded.



Enable to show the Transfer Summary window    when files are downloaded. Use this window to open or delete files.



Enable to minimize the transfer dialog. The minimized dialog appears at the bottom of the screen.



Enable to change the default name of files before downloading them.



Enable to flash the icon of a minimized Cyberjack program on the Windows Task Bar when files are downloaded.



Enable to maximize a minimized Cyberjack program when files are downloaded.



Enable to play a Windows system sound when files are downloaded.



Enable to notify you when each file transfer in a group transfer is complete.



Enable to notify you when a group transfer is complete.



Enable to set up the type of notification you want when files are downloaded.



Specify how you want to be notified after group transfers.



Browses for the folder to receive all downloaded files.



Specify the options for file transfers.



Enable to check for viruses in the downloaded files.





Your password for the Guidebook.



Your password for the Guidebook.



Lists the folders and files in the selected location.



Lists the folders and files in the selected location.



Type the name of the file.



Type the name of the file.



Selects the type of file to save.



Selects the type of file to save.



Opens the file with the name, file type, and location you specified.



Saves the file with the name, file type, and location you specified.





Connects to a new FTP session.



Opens FTP session CyberLink.



Closes FTP session.



Saves FTP session to Guidebook.



Saves FTP session to Guidebookwith new name.



Displays FTP session properties.



Email FTP session CyberLink.



Closes the program.



Copies selected text to Clipboard.



Inserts Clipboard contents.



Deletes the selection.



Selects the entire document.



Selects all previously unselected items.



Finds specified text.



Repeats last find.



Toggles Toolbars.



Toggles Status Bar.



Repositions vertical splitter bar.



Repositions horizontal splitter bar.



Displays items in large icon format.



Displays items in small icon format.



Displays items in list format.



Displays detailed list of items.



Sorts items by name.



Sorts items by type.



Sorts items by size.



Sorts items by date.



Auto-arranges listed items.



Go to previous page.



Go to next page.



Reloads current host directory.



Diagnoses an Internet connection.



Displays contents of Download folder.



Retrieves files from the host system.



Sends current file by email.



Sets current directory on host system.



Creates new folder on host system.



Displays properties of selected files or folders.



Changes FTP options.



Upgrades Cyberjack.



Displays index of FTP Help topics.



Displays index of Cyberjack Help topics.



Toggles FTP Connect wizard.



Toggles Tip of the Day.



Displays program information, version number and copyright.



Stops data transfer. 



Click the What's This button, and then click a menu command or screen component to receive context sensitive help.





Lists the available folders and files. 



Lists the folders and files in the selected location.



Type the name of the file.



Selects the type of file to save. 



Closes this dialog box without saving any changes you have made. 



Saves the file with the name, file type and location you specified.




